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Welcome 

Welcome to MEASUREspy, a powerful tool that helps you select and 
use data gathered from external measurement devices. MEASUREspy 
saves you valuable time, effort, and resources; no longer will you 
have to copy data manually from devices to other software programs 
to track the quality of your products. 

MEASUREspy accepts data either directly from a device through a 
COM port or from an ASCII text file. It filters through all the data, 
extracting only the data you are specifically interested in analyzing, 
and sends this data directly to an ASCII text file, an Excel spread-
sheet, or an SQCpack database. And since MEASUREspy allows you 
to move the data directly from the device to another software 
program, mistakes caused by human error are eliminated, making 
your results accurate and cost-effective. 

About your MEASUREspy documentation 
MEASUREspy includes the following: 

❖ MEASUREspy User Guide (this book) 

❖ On-line Help This provides descriptions of the application’s 
commands and functions. It appears when 
you select a Help command or press 1. 

About PQ Systems 
Productivity-Quality Systems, Inc. is a full-service firm dedicated to 
helping customers continuously improve their organizations. We 
offer a comprehensive suite of products and services designed to 
improve quality, productivity, and competitive position for all indus-
tries. The full line of improvement products and services from  
PQ Systems includes: 

SQCpack® for Windows   combines powerful SPC techniques with 
flexibility and ease of use. In addition to variables, attributes, Pareto 
charting, and capability analysis, SQCpack for Windows features 
real-time charting, alarming, SQC Quality Advisor,  ODBC, filtering, 
and an easy setup wizard. SQCpack is easily networked and the 
program comes with free technical support. 
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PORTspy  Plus 2.5 transfers data easily from a wide variety of 
measuring devices into SQCpack for Windows and other popular 
software programs. PORTspy Plus saves time, eliminates data input 
errors, guides users through setup with an easy-to-use wizard, and 
manages data from multiple devices simultaneously. 

GAGEpack® for Windows allows you to record all gage events in a 
database. This software will aid you in maintaining an unlimited 
number of gage records that record descriptions, calibration 
procedures and histories, and vendor information of all your gages. 

Quality Workbench© helps organizations with the daily control of 
their quality systems in order to comply with ISO 9000 and QS-9000. 
It features document control, audits and non-conformities, customer 
complaints, and personnel training records. 

R&Rpack® use the power of a personal computer to perform tedious 
repeatability and reproducibility studies with minimum effort. 

DOEpack® allows you to find the optimal conditions in a process by 
setting up and analyzing experimental designs for all stages of 
production. 

SPC Workout is an interactive, multimedia training course that 
provides effective step-by-step instruction on implementing and 
using statistical process control. 

FMEA Investigator is an interactive, multimedia training course 
that provides effective instructions on conducting both design and 
process FMEAs. 

Total Quality Transformation® offers step-by-step help in facilitat-
ing the quality transformation in organizations. TQT is a part of the 
Transformation of American Industry® training project which has 
been used in a variety of manufacturing and service organizations 
since 1984. 

Consulting and Training Services are offered by PQ Systems for 
companies at all stages of their quality management programs. A 
staff of highly-qualified consultants brings practical experience from 
both industrial and academic environments. Seminars and on-site 
training programs are available to help companies implement 
successful quality management programs. 
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Reaching PQ Systems Sales and Technical 
Support 
PQ Systems invites your questions and comments about our prod-
ucts and services. 

Sales    1-800-777-3020 
Call Sales for: 

❖ General information to help you decide to purchase or evaluate 
the software 

❖ To place an order or check the status of an order 

The E-mail address is: 
❖ Internet: sales@pqsystems.com 

Fax    1-937-885-2252 
You can send a fax to either Sales or Technical Support. To ensure 
that your fax is delivered quickly to the right department, please 
send it to Attn: Sales or Attn: Technical Support. 

World Wide Web URL 
http://www.pqsystems.com 

International offices 

PQ Systems Europe Ltd. 
Ryeground House, Ryeground Lane, Freshfield, 
Formby, Merseyside, L37 7EQ England 
Tel. 01704 871465 
Fax 01704 875189 

PQ Systems Pty. Ltd. 
Level 6, Peninsula Centre 435-437 Nepean Highway 
Frankston, Victoria 3199 Australia 
Tel. 03-9770-1960 
Fax 03-9770-1995 
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Technical Support  1-800-777-5060 
Call our experienced technical support team free of charge. They 
can answer questions about software problems, data analysis, and 
applications. 

Before you call 
Please follow these steps to help our technical advisors answer your 
questions quickly: 

❖ Have your serial number ready. It is listed on Disk 1 and in the 
About MEASUREspy dialog box. 

❖ Be at your computer, if possible. 

❖ Review the topic for which you have a question in the User 
Guide. 

The e-mail address is: 
❖ Internet: support@pqsystems.com 
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Section 1 

MEASUREspy overview 

This section provides an overview of MEASUREspy so that you will 
understand the program’s functions before you get started. 

People use digital measurement devices for several reasons, including 
to ensure that their products are of the highest quality and to deter-
mine that different machines are working properly. These devices 
generate large amounts of data for each characteristic being measured. 
Before  MEASUREspy, an unfortunate technician might get stuck 
with the tedious task of sorting through all this data to find specific 
items of interest and then analyzing them. If the person looking at the 
data were using a computer for analysis, he or she would have to 
manually enter the data into a database or a spreadsheet. 

With MEASUREspy, the dull, repetitive tasks of sifting through pages 
of data and then inputting it into a computer can be eliminated. This 
powerful tool allows you to extract data either from an ASCII file or, 
by connecting the device directly to your computer, from the device’s 
data stream. 

MEASUREspy is similar to the screen-like tool coffee bean growers 
use when separating larger beans from smaller ones. Imagine that a 
coffee grower wants to sift out all the smaller coffee beans, leaving 
only the largest, so he or she places all the beans in the sifting screen 
and shakes until the smaller beans fall out, leaving only the larger 
beans in the sifter. This sifting screen works similarly to 
MEASUREspy, combing through large amounts of material, and then 
choosing only specific portions. 

Now imagine that the coffee grower wants only the half of the beans 
that are darker green, leaving the lighter half behind. He also wants 
the beans arranged by shape. Sorting and arranging all the beans by 
hand would be very time consuming and costly, not to mention 
boring. He would need a very sophisticated tool that could not only 
sort but also arrange and analyze the beans. The tedious task of 
sorting the beans can be compared to extracting and analyzing data 
from a measuring device. 
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MEASUREspy is capable of sifting through massive quantities of 
information, pulling out only the data you need, and arranging that 
data in a way that you specify. To harness MEASUREspy’s power, 
you need to answer a few questions, and tell the program what 
information you want it to look at, and then what to do with that 
information. 

The MEASUREspy interface consists of a single form that is divided 
into five tabs. Each tab contains the configuration fields needed to 
complete a particular part of the set up. For example, click on the 
Format, Fields tab to specify the data format and mark the data 
fields that you want MEASUREspy to access. This tab system helps 
you set up the program in an appropriate order, so the setup process 
is as direct and simple as possible. 

The first question that MEASUREspy asks is where the information 
will be coming from, what is the Source of the data. This may be an 
ASCII file or directly from a COM port. 

When you have answered this question, click on the next tab to tell 
the program what Format the data is in, positional or delimited. 
Within this tab, you also define Fields to tell the program which 
data you want it to extract. The Destination tab asks where you 
want MEASUREspy to send the data that you want to examine. (You 
have three choices: to another ASCII file, to an Excel spreadsheet, or 
an SQCpack database.) Through the Prompts tab, you can add to 
optional startup prompts to include additional information that 
helps identify the data. 

The heart of the program is on the Rules and Outputs tab. This is 
where you tell MEASUREspy what you want to look for within your 
data and what you want to do with that data once MEASUREspy 
has sorted through the information. The Rules and Outputs 
function is a bit more complex than the rest of the program, but you 
need to input this information only once; MEASUREspy will then do 
the rest. To help you get MEASUREspy’s Rules and Outputs set up 
as quickly and easily as possible, read Section 5, “Configuring the 
Rules and Outputs Tab” in this User Guide. To begin extracting data, 
go to the final tab and click on Start! 
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Section 2 

Terms and concepts 

Connecting the components 
MEASUREspy an interface; it facilitates communication between 
your measuring device, your computer, and another program to 
which you want the results of MEASUREspy’s work to be sent. The 
broad term device is used throughout this Guide to refer to several 
different types of measuring tools, including coordinate measuring 
machines (CMMs), lasers, optical comparators, and electronic 
scales.. 

To connect your device directly to your computer, you will need to 
use an RS-232 cable. Most devices have a port, an external socket 
where you can plug in an RS-232 cable or some other piece of 
equipment. The other end of the cable connects to one of the COM 
(communications) ports on your computer. Most computers have up 
to four COM ports. A mouse and other peripheral devices are also 
connected to computers through COM ports. 

Configuration files 
MEASUREspy saves and uses its own files. These are called configu-
ration or MSW files. You may create and save as many of the MSW 
files as you need. MSW files are simple text-based files. If you are 
curious about what they contain, you can use the Windows Notepad 
program to open an MSW file. If you have ever looked at a 
program’s INI file, you will recognize the format that is used in 
MSW files. 

The data source and communication 
parameters 
MEASUREspy’s Source tab asks you to select the source of the data, 
ASCII text files or a COM port. Some measurement devices store 
the data in an ASCII text file on a diskette. MEASUREspy can read 
ASCII files after you put the diskette into your computer and tell 
MEASUREspy where the file is located. 

2 
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If your measurement device is connected directly to the computer 
through a COM port, you will need to configure MEASUREspy to 
communicate with the device. When you select COM port as the data 
source, you will be prompted to set up communication parameters. 

The port numbers refer to the COM port to which your measurement 
device is connected. The baud rate refers to how fast your device can 
send data to another source. Parity helps the computer check 
whether the data it receives is the same as the data that was sent. 

Setting the flow control helps the computer coordinate communica-
tion with the device.  XON/XOFF represents a signal that the 
computer sends to the device when it cannot accept any more data 
for the moment, and then it sends another signal when it is able to 
accept more data. Similar to XON/XOFF is the setting RTS/CTS. 
RTS, which stands for “Request to Send,” is a signal sent from your 
device to your computer asking permission to begin transmitting 
data. CTS, Clear to Send, is the answer that your computer sends 
back to your device, indicating that it is ready to begin accepting 
data. The setting RTS/XON/XOFF is a variation of the settings 
discussed above. 

Data bits are the number of bits used to represent one character of 
data. With ASCII code, the typical setting is either 7 or 8, but a few 
devices use 5 or 6. Either 1 or 2 Stop Bits are added to the end of each 
piece of data. Having a stop bit following each piece of data is similar 
to putting a period at the end of every sentence. 
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Just follow the setup instructions from your device’s user guide or call 
the technical support team for your device to get the proper settings. 
These options will only have to be set once for each of your measuring 
devices. MEASUREspy will then save these settings. 

Data Format 
When your device sends data to your computer, it will be formatted in 
one of two ways, either positional or delimited. 

Positional data 
If your data is positional, then the same data will be displayed in the 
same columns throughout the file. You could take your finger and run 
it down the screen and touch the same types of measurements all the 
way down. Think of positional data as being held in an invisible grid. 

Delimited data 
With some files, data is separated by delimiters, such as commas, 
semicolons, or tabs. For delimited data, it is not usually possible to run 
your finger straight down a screen and touch all occurrences of that 
particular type of data. You could not draw a grid over delimited data 
and have a certain type of measurement fall into the same column 
every time. 

It is important that you tell MEASUREspy how your data is 
formatted, because the fields are defined differently for each type. 
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Data Fields 
Think of a field as blank space that can hold different pieces of 
information. For example, imagine the blanks on a form prompting 
you to enter your name and address. Each of these blanks is a field. 
With MEASUREspy, you will need to mark each field of data that 
you want to extract. 

Output Types 
Through the Destination tab, MEASUREspy provides three options 
for data output: an SQCpack database, an ASCII text file, or an 
Excel spreadsheet. 

An SQCpack database, which is also a Microsoft Access database, 
contains various tables that have been set up for quality monitoring 
and improvement.  You can then analyze the data through control 
charts or histograms. 

An ASCII file is a simple text-based file that can be viewed using the 
Windows Notepad, WordPad, or Excel. ASCII files are the most 
versatile, since many Windows applications are able to open and/or 
import data from them. 

Excel spreadsheets are files that can be used by the Microsoft Excel 
spreadsheet application. 

The Rules and Outputs 
On the Rules, Outputs tab, you will be asked what portions of the 
data you want MEASUREspy to extract and examine. You can 
choose which field the program should look at and what it should 
look for in that field. For example, suppose you are measuring the 
temperature of a random sampling of crayons as they come off the 
assembly line. You want MEASUREspy to look at all readings above 
75°F. You could set up a rule that says, “When Field3 [the tempera-
ture] is greater than 75, set Id—> [identifier] to Field1 [crayon 
batch].” This rule will produce a list of crayon batches whose 
temperatures were more than 75°F. 
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Section 3 

Installing and starting 
MEASUREspy 

This section lists the equipment that you need to run MEASUREspy 
for Windows, explains the README file, gives installation instruc-
tions for the software, and tells you how to start and exit 
MEASUREspy. 

Hardware and Software Requirements 
You need the following to run MEASUREspy: 

� 486 or higher IBM-compatible PC with at least 8 megabytes of 
memory 

� A hard drive with approximately 10 megabytes of free space 

� VGA or SVGA graphics adapters 

� MS-DOS version 5.0 or higher 

� MS-Windows version 3.1, Windows 95 or 98, or Windows NT 
version 4.0; Windows 95 or higher recommended 

Using the Installation README File 
We strive to continuously improve our software and occasionally 
make changes that affect the use or appearance of MEASUREspy. 
Because these changes may not be major, but rather an effort to fine- 
tune MEASUREspy, the changes may not always be reflected in the 
User Guide. Instead, we include this information in a README file 
on the disks that contain the program files. 

This file has a separate icon in the MEASUREspy group or folder. To 
open a README file, double-click on this icon. 

3 
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Installing MEASUREspy 
To install MEASUREspy using Windows 3.1: 

1. Start MS-Windows and open the Program Manager. 

2. Use the mouse or shortcut keys to open the Program Manager’s 
File Menu and select Run. 

3. Place MEASUREspy Disk 1 in your disk drive. 

4. In the Run window, type the letter of your disk drive, followed 
by a colon, backslash, and the word setup. For example, if your 
MEASUREspy disk is in your A drive, you would type A:\setup. 

5. Select K. You will be prompted to enter your name and 
your company’s name (if applicable) to proceed with the instal-
lation. Follow the on-screen instructions to complete the 
installation. 

 
To install MEASUREspy using Windows 95, 98, or NT 4.0: 

1. Place MEASUREspy Disk 1 in your disk drive. 

2. Click the Start button located in the bottom left-hand portion of 
your screen. 

3. Select Run. 

4. Either use the Browse feature to locate and double-click the 
setup file, or type in the name of the disk drive the 
MEASUREspy disk is using, followed by the letters setup.exe. If, 
for example, you have the MEASUREspy disk in your A drive, 
type A:\setup.exe. 

5. Click Open. You will be prompted to type in your name and 
your company’s name (if applicable) to continue with the 
installation. Follow the on-screen instructions to complete 
MEASUREspy’s installation. 

 

Starting MEASUREspy 
To start the program: 

1. Start Windows. 

2. Double-click on the MEASUREspy icon. 
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Exiting MEASUREspy 
To exit the program: 

� Press A + 4 or open the File menu, and select Exit. 

Menus 
There are three menus in MEASUREspy: File, Edit, and Help. 

The File Menu 
The follow commands are accessed through the File Menu: 

❖ New Creates a new configuration (MSW) file. 

❖ Open Opens a selection window so that you 
can access an existing MSW file. 

❖ Save Saves the current MSW file. 

❖ Save As Allows you to save the current MSW file 
as a new file. 

❖ Preferences Opens the Preferences form.  See 
Preferences at the end of this section for 
information on setting preferences. 

❖ Exit  This closes the program. 

The Edit Menu 
The following commands are accessed through the Edit Menu: 

❖ Copy rules Copies all rules to the Clipboard 

❖ Paste rule Pastes all rules from the Clipboard into 
MEASUREspy at the insertion point (where 
the cursor is located). 

❖ Duplicate last rule Copies the last rule that was entered into the 
current row. 

❖ Insert row Inserts a blank row in the Rules table. 

❖ Delete row Deletes the current row in the Rules table. 
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The Help Menu 
The commands in this menu include: 

❖ Contents Takes you to the Help file’s Contents screen. 

❖ Search for Help on Takes you to the Help file’s search form. 

❖ Obtain Technical Provides contact information for PQ Systems 
Support Technical Support staff 

❖ About MEASUREspy Provides the version number. 

Preferences 
Use this form to set program preferences. To display this form, open 
the File Menu and select Preferences. Click on K to close the 
form when you have finished setting preferences. 

General Preferences 

Recognize blank fields as numeric 

Select this option if you want MEASUREspy to treat all blank field as 
though they contain numeric data. 

Allow fields to be the subject of comparisons 

Select this if you are creating rules that compare two or more fields. 
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Allow answers to be the subject of comparisons 
Select this if you want to use rules to compare the answers given to 
Startup Prompts. For example, if you have a prompt that asks users 
for their shift number, you can set up rules to enter data from Shift 1 
in one output field and from Shift 2 in another output field. 

Allow variables to be the subject of comparisons 
Select this option if you want to set up rules that compare variables. 

SQCpack Preferences 

Allow program to create SQCpack groups 
If selected, this preference will add two options, New Group and 
New Char, ss=n to the group and name menus in the Outputs grid. 
With this preference selected, MEASUREspy will create one new 
group each time it is run. The group may have several identifiers and 
characteristics with a mixture of sample sizes. 

If indirection is used, then MEASUREspy may locate the group name 
and characteristic names within the data. If the group name is not 
recognized and this option is checked, MEASUREspy will create the 
group and add characteristics as determined by the Rules. 

Allow program to write partial rows to SQCpack 
Usually a sample will not be written to SQCpack until the row of data 
is complete (although it is not necessary to fill in all the identifier 
fields). Occasionally it may be desirable to suppress the behavior. For 
example, if a group contains characteristics of Length and Width, 
MEASUREspy would not normally send a sample to SQCpack until a 
reading for each was available. By checking this option, you can force 
MEASUREspy to send a column of Width readings taken when no 
data is available for Length. 

Checking either of the above options will force 
MEASUREspy to pass the input file twice when 
writing to SQCpack. The first pass is used to gather 
information and the second to write the data. 

Log SQCpack data that is out of specification 
If you have defined a log file to receive messages about the 
conversion(s), checking this option causes MEASUREspy to write one 
line to the log each time a characteristic value that is outside the 
specification(s) defined in SQCpack is sent. 
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Excel Format 

If you will be outputting to an Excel file, specify whether you are 
using version 4.0 or 5.0. 

Applications to view output results for 

Use this field to specify the program that you want to use to view the 
output. You can specify application for each output type. To do this, 
enter the path and file name in the field provided. For example, if 
your SQCpack database is located on your C drive, the location of the 
program file may be: c:\sqcwin30\sqcwin30.exe. 

MEASUREspy can send data directly to an SQCpack 
database even while the database is in use as long as 
the data table is not locked. This means that 
MEASUREspy is unable to write to a group while 
another user is editing data for that group—although 
it is perfectly possible to view charts and update 
them as MEASUREspy collects data.  In fact, this 
combination of MEASUREspy and SQCpack forms a 
powerful monitoring tool that can provide feedback 
nearly in real-time from a variety of processes where 
the data is being collected from a previously unread-
able device. 

Editing the data in SQCpack refers to any screen that 
opens through the data editor. For example, clicking 
on the Enter data button and then a Default Chart 
icon displays a chart, but the program is still in the 
editor. Hit the E key to confirm this. To enable 
MEASUREspy and SQCpack to generate near real- 
time charts,  display the charts directly from 
SQCpack’s charting buttons (Control Charts, Histo-
grams/Capability, or Multi-chart). 
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Section 4 

Setting up MEASUREspy 
configuration files 

This section discusses each of MEASUREspy’s tabs, menus and 
options. It will walk you through each step so that you can use 
MEASUREspy knowledgeably and effectively. 

It is important to go through the tabs consecutively. 
Start with the Source tab, and work your way 
through the tabs from left to right. 

Selecting a source 
You have two data source options: 

� Select Data will come from one or more ASCII files, if your 
device stores data on a hard disk within the device, or if you 
want MEASUREspy to read several ASCII files simultaneously. 
You should also select this option if your device is not connected 
directly to a computer. 

� If you would like to have your data go straight to MEASUREspy 
as the device is taking the measurements or in batches (such as 
from a data-logger), then select Data will come from a commu-
nication port.    

Data will come from one or more ASCII files 
To extract data from one or more ASCII file: 

1. Data will come from one or more ASCII text files is the 
default option. It is the active option if the radio button is 
selected and there is a Source file field below. If it is not selected, 
click on the radio button. 

2. Type the name of the file in the Source file field or click on the 
Browse button to search for the file you want. Click once on the 
file name to select it, then click K. 

4 



22 MEASUREspy 

If you want to extract data from multiple files, use a wild card 
character (*). If, for example, you want to pull data from three 
files (mini1.txt, mini2.txt, and mini3.txt) located in the mspy 
directory, you would type the following in the Source file text 
box: 

c:\mspy\mini*.txt 

This command will provide access to all files within the mspy 
directory that begin with the letters “mini.” 

       

You must follow a few guidelines when setting up multiple 
source ASCII text files. 

� The files must all be in the same folder (i.e., c:\mspy). 

� You can use either file names that share certain letters (i.e., 
mini) or wildcard characters. Note, however, that typing 
c:\mspy\*.txt would open up all ASCII text files found in 
that directory. You may want to move the files that you do 
not want MEASUREspy to access. 

3. Once you have the location of the file(s) entered into the Source 
file text box, click the Read Data button. MEASUREspy will 
display up to the first 100 lines of your source text, regardless of 
how large the text file is. 

Other options for ASCII files 

Import new files only 
This option is valuable when all of your ASCII files have similar 
names. If you select this option, MEASUREspy will ignore all the old 
files and read only those files that it has never opened.  Click on this 
option to select it.  A check mark will appear to the left of the option 
if it has been selected. 
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Delete source file(s) after use 
If you have several files created each day that you will no longer need 
after MEASUREspy has analyzed the data and sent it to another file, 
you may choose to Delete source file(s) after use to save space on 
your computer. Click on this option to select it.  A check mark will 
appear to the left of the option if it has been selected. 

Automatically scan for new files every ____second(s) 
MEASUREspy can run unattended, so no one has to stay at the 
computer entering new source file names. With this option, 
MEASUREspy will automatically search for new files as often as you 
choose. Click on this option to select it.  A check mark will appear to 
the left of the option if it has been selected. Then enter the number of 
seconds in the field provided. 

Data will come from a communication port 
If your want MEASUREspy to read your data directly from the 
device, and your device is connected to the computer through an 
RS-232 cable, click on the Data will come from a communication 
port (COM Port). 

When you select this option, you will be prompted to set the commu-
nications parameters (discussed in Section 2, Terms and Concepts). 

1. Consult the device’s documentation or vendor for the correct 
settings for your device. 

2. Click on the radio button to the left of the each setting required. 
You will need to specify the port to which the device is connected 
and the baud rate, parity, flow control, data bits, stop bits, and RTS. 

For more information on these communication parameters, refer 
to Section 2, “Terms and Concepts.” 

3. After you have selected the correct settings, click on the Read 
Data button to begin receiving information from the device. 

After you select Read Data, you will need to send data from the 
device. 

If all the settings are correct, the data that appears at the bottom of 
the screen should make sense. If your data contains junk characters, 
one or more of the settings is probably incorrect. 
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MEASUREspy will display only the first 100 lines of 
the data. 

Once you have successfully entered the source of the information 
and MEASUREspy has read the data, you are ready to move to the 
next step, defining the fields. 

Defining the Fields 
The second tab is Format, Fields. Use this tab to specify the data’s 
format and to select which data you want MEASUREspy to extract. 

Format 
To specify the data’s format: 
1. Determine if your data is positional or delimited. If you are not 

sure, see the descriptions in Section 2, “Terms and Concepts.” 

2. Select the option for your data’s format.  If it is delimited, you 
will need to select a delimiter from the drop down menu. 
Options are: semicolons, tabs, commas, and spaces. 

It is important that you tell MEASUREspy how your data is format-
ted, because the fields are defined differently for each type. 

Defining Positional Data Source Fields 
1. Determine which data you want MEASUREspy to examine. 

2. Position the pointer either at the beginning or the end of the first 
piece of data that you want, then hold the mouse button while 
dragging across the entire piece of data you want. When the 
data has been highlighted, release the mouse button. Check to 
make sure that all the data has been highlighted in yellow. 

3. While the selection is still highlighted, click the Define Field 
button. When you do this, three things should happen: 

� Your selection will turn from yellow to blue. 

� The term “Field1” should appear in the Fields dialog box, 
along with the coordinates of the field including the row (R), 
column (C) and width (W). 

� When you position your pointer over the selection, the tool 
tip will read “Field1”Fields that appear on multiple rows only 
need to be defined once. 
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Repeat this procedure until you have defined all the data fields you 
want to analyze. Since the screen does not display all the information, 
you may need to use the scroll bars to view and define some fields. 

You must define each field so that all the information 
you are interested in will fit. For example, suppose 
that you are defining a temperature field, and the 
first time the data occurs, the reading is 92.04ºF. You 
know that some readings will exceed 100.00ºF, so you 
need to define the field so that it is large enough to 
capture all the digits. 

To do this, simply highlight the space before and the 
space after 92.04 so that the larger numbers will be 
included in that field. Once you have a field defined 
that will hold all readings for the temperature 
measurement, MEASUREspy will be able to read all 
your data and search for the temperature reading in 
the columns you have defined. 

Defining delimited data source fields  
When you select delimited as the data format, MEASUREspy replaces 
the delimiter (comma, tab, etc.) with a vertical line (in the display 
window, not the source file). These lines separate and align each type 
of information into its own column to help you see which measure-
ments are which. 
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Using the Text qualifier feature, you can tell the program how your 
labeling information is set up, in double quotes, single quotes, or 
using no text qualifiers. With this information, MEASUREspy will 
be able to recognize which pieces of data are labels rather than 
measurements. To define a field: 

1. Click on the column of information you wish to select. The 
column will be highlighted with yellow. 

2. Now click the Define button. Once you have defined a field, the 
following will occur: 

� A tool tip will appear with the term “Field1” 

� The Fields dialog box will contain the entry “Field1,” along 
with the coordinates of the field, including the row (R), 
column (C), and width (W) 

� When you move your cursor to another column, the first 
field you have defined will now be highlighted in blue 

Define all fields you want to be included using this same procedure. 
You may need to use the scroll bars to scroll down or to the right to 
define all the fields you need, since all the information in your data 
file will probably not fit into the display screen. 
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Editing a field definition 
If you make a mistake while defining a field or if you change your 
mind about a particular field: 

1. Position your cursor over the field until the tool tip appears. 

2. Hold the mouse button down while dragging your cursor over 
the selection you would like to define as the field. 

3. Click again on the Define Field button to redefine the field. 

Deleting a field 
You have two options for deleting fields: 

� Highlight the field you want to delete within the Fields dialog 
box, and then click the Delete button. 

� Reset all fields by clicking on the Clear All button 

Finding a field 
There are two options for locating a specific field: 

� Highlight the name of the field in the Fields box. Then click on 
the Go to button. 

� Move your cursor around until the tool tip displays the field you 
seek. 

Choosing your destination file 
Once you have selected a source, and defined the format and data 
fields, you need to specify the type of output and the file to which 
you want your data sent. 

1. Click on the Destination tab. 

2. Click on the type of output file you want. Options are: 

� to an SQCpack database 

� to an ASCII text file 

� to an Excel spreadsheet 

3. Type in the name of the destination file, or click on the Browse 
button to open the Selection window. Select the path and file 
name, then click on K to return to the Destination tab. 
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If you choose to transfer the data to an SQCpack database the new 
information will be appended to the destination file you select. 

If you choose to transfer the data to an ASCII text file or an Excel 
spreadsheet, you may either start a new file each time (which will 
overwrite any existing file of the same name) or append to an exist-
ing file. Click on the Append to existing file option, if you want to 
append the data. 

If you select Excel as the output file type, you will need to let 
MEASUREspy know whether this is an Excel 4.0 or 5.0 file.  To do this: 

1. Open the File Menu and select Preferences. 

2. Click on Excel Format 4.0 or 5.0, to select the correct format. 

3. Click on K. 

Writing Optional Log Messages 
MEASUREspy can run automatically without an operator.  Since 
MEASUREspy may be running without anyone watching the com-
puter, error messages flashing on screen would be useless. Therefore, 
you may want to set up a log file to record all error messages. 
MEASUREspy log files also contain information about which files 
were opened and when. 

To set up a log file: 

In the Write log messages to this file field, type in the name and 
path of the log file, or click on the Browse button to open the Selection 
window. Select the path and file name, then click on OK to return to 
the Destination tab. 

If MEASUREspy is writing data to an SQCpack database, you can set 
MEASUREspy to log any data that falls outside specifications for that 
characteristics. To do this: 

1. Open the File Menu and select Preferences. 

2. Click on, Log SQCpack data that is out of specification, so that 
a checkmark appears in the checkbox for this option. 

3. Select K. 

In order for this function to work, the upper and 
lower specifications of the characteristic you are 
examining must have been defined within the 
SQCpack database. 
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Using Startup Prompts 
MEASUREspy allows you to gather additional information about the 
data. For example, if you want each operator to enter his or her name, 
you can set this up through the Prompts tab. Operators would then 
be prompted to enter their names when they start running the 
configuration file. You can set up to 10 startup prompts. 

To set up Startup Prompts: 

1. Click on the Prompts Tab. 

2. Type a category for the prompt in the Startup user prompt field. 
With the above example, you might enter Name or Operator in 
this field. 

3. If you want operators to choose the answers from a choice list, 
move the cursor to the Choice list field for the current category. If 
you use this option, the user will be able to choose the response 
from a drop-down list when the prompt appears without manu-
ally having to enter the information each time. This can reduce 
the occurrence of data entry errors.  To do this: 

A. If you already have choice lists, use the drop down menu to 
select the list you want operators to use for this category. 

B. If choice lists do not yet exist or if you want to edit an 
existing choice list, click on the Edit choice list button. The 
Choice list form will open. 

Type a name for the list in the top field, or select an existing list. 

Type the choices for this list in the bottom field or make any 
desired changes. 

Click on K. 
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4. Select Yes in the Match list? field, if you want the item the 
operator enters to match an item in the Choice list.  Select No, if 
you want to allow operators to enter items not currently in the 
choice list. 

 Choice lists are text files with a .TXT extension 
stored in the directory defined by the ‘CLDir=’ entry 
in the program’s initialization (.INI) file. 

The Rules and Outputs 
Chances are, you already know which data you want the program 
to extract, because this is a task that you have been performing 
manually. MEASUREspy will extract the data exactly as you want it 
to by following the rules that you set up. While setting up rules may 
be the most challenging part of the configuration, most tasks can be 
accomplished with only two or three rules. Also, keep in mind that 
there are several ways in which to set up rules that will result in the 
same output. 

Perhaps the best way to help you set up the rules and outputs that 
you require is to acquaint you with the way this function works. 
User Guide Section 5, “Configuring the Rules and Outputs Tab,” 
provides a detailed look at this function. The first part explains how 
MEASUREspy uses rules. Next is a brief tutorial that runs through 
several scenarios using the sample files included with 
MEASUREspy. This is followed by several examples of rules that 
have been set up using different scenarios for each type of destina-
tion file. A reference guide to the different functions of rules and 
outputs is at the end of the section. 

Reading the explanation and reviewing the examples should help 
you to understand the basics of the rules and outputs feature. The 
reference section should help as you set up your own rules and 
outputs. However, if you have problems setting up this feature, our 
technical support staff can help walk you through the process of 
getting MEASUREspy to perform all the tasks you have in mind. 

Running the configuration 
Once you have completed the information on the other tabs, you are 
ready to run MEASUREspy. To do this: 

1. Click on the Start! tab. 
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2. Click on the Start! button. If your data source is a device 
connected to the COM port you may need to send data from the 
device. 

The Lines read and Lines written boxes show how many lines of 
data have been processed. Once MEASUREspy is finished, you can 
view the results. 

The View feature  
If you have set the viewing preferences, you can view the output 
result by clicking on the View button.  If you have not set the view-
ing preferences: 

1. Open the File Menu and select Preferences. 

2. In the Applications to view output results for fields, specify 
the program that you want to use to view the type of output. To 
do this, enter the path and file name in the field provided. If you 
plan to use only one type of output file, specify the application 
for only that type. 

For example, if the SQCpack program is located on your C drive, 
the location of the program file may be: 

c:\sqcwin30\sqcwin30.exe 

Notice that for ASCII destination files, MEASUREspy has been 
preset to Notepad. If you would prefer to use another applica-
tion to read your ASCII destination files, like WordPad, which is 
able to read a much larger file than Notepad, simply change the 
location of the application. 

3. Once you have all your program files set up, click K. Now, 
when you have defined your destination file as an SQCpack 
database and you click the View button after running 
MEASUREspy, it will take you directly to the SQCpack program. 
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Section 5 

Configuring the Rules and 
Outputs 

5 

MEASUREspy is a powerful tool that many people will find invaluable. 
It is unlikely, though, that any two people will use MEASUREspy in 
exactly the same way for identical purposes. Since the program will 
become specialized for each of its users, you will not find a set of 
standard rules to copy into your program. 

In this section, you will find the following topics: 

� How MEASUREspy Uses Rules 

� Tutorial 

� Example Rules 

� Examples of Data Sent to an SQCpack database 

� Examples of Data Sent to an ASCII file 

� Examples of Data Sent to an Excel spreadsheet 

� Reference 
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How MEASUREspy Uses Rules 
MEASUREspy reads the source data one line at a time in much the 
same way that many people read books, one line at a time, from left 
to right. MEASUREspy reads each of these lines only once and then 
moves on. Sections of each line that are of interest to the user can be 
defined as fields. 

If necessary, MEASUREspy can remember fields it has seen by 
placing them in variables. Think of these variables as storage boxes 
that hold specific data until the box is emptied (or the variable is 
overwritten) and replaced with something else. 

MEASUREspy also allows for various outputs. These outputs can be 
connected directly with previously-defined SQCpack groups and 
characteristics in order to move the relevant data directly to where 
you need it. The output for ASCII or Excel destination files may only 
be of two types, identifier (ID) and observation (Obs). 

After MEASUREspy has read a line of data, it applies each of the 
“rules.” The basic form for a rule is: 

When this meets this criterion do that 

One valid rule, then, would be: 

When Field1 Is equal to Result Set Output To Field2. 

In most cases, two or three rules will be enough for MEASUREspy to 
understand and process your particular data. 

The secret to devising effective rules is to ask yourself what you are 
trying to achieve, by looking at the source data. Once you have 
determined this, your job is almost done.  Write a few rules that 
accomplish this task and MEASUREspy will complete the job for you. 

Begin by considering the source data. Is there a reading in the same 
position on every line or will you have to be more selective? For the 
former, a rule like the following may be sufficient: 

When Fieldn Is Numeric Set Outputm To Fieldn 

If, however, you want data only from certain lines, you will need a 
means of identifying the lines you wish to select, so look for some 
significant feature that is unique to just those lines. 

When the information from a previous line is relevant to a reading 
further down, you will need to remember that information by storing 
it in a “variable” and then recalling it when you output the data. 
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Beware of making your rules unnecessarily complicated.  For example, 
with the sample file CMM3.TXT, you might set up a rule like this: 

When Field4 is numeric …. 

Or use: 

When Field3 is Equal to DIAMETER…. 

It is tempting to combine these two rules into one: 

When Field3 is Equal to DIAMETER and When Field4 is Numeric…. 

Executing the program will confirm that this works perfectly well. 
However, the first condition (Field3 is Equal to DIAMETER) implies 
the second. Under these circumstances Field4 is certain to be numeric, 
so the second half of the rule is superfluous.  This is not serious and the 
small amount of overhead (created because the computer has more 
work to do) would hardly be noticed. However, this makes the 
situation look more complex than it really is and should be avoided. 

In the Rules grid, Id� means that the data will be sent 
as an identifier, and Obs� as an observation. The 
number of observations is counted and the line is 
output when the number reaches the value set by the 
user. Then the count is reset to 0. 

Let’s take a look at the following tutorial and then several examples to 
see how MEASUREspy uses specific rules. 
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Tutorial 
Work through the following steps using the sample files included with 
MEASUREspy to learn more about the use of rules. 

You will find sample source files in the 
MSPY\SAMPDATA directory. The sample MSW files 
are in the MSPY\SAMPMSW directory. 

1. Open MEASUREspy. The Source tab should be on top. If not, click 
on Source to select it. 

2. The option Data will come from one or more ASCII files should 
be selected. If not, click on this option to select it. 

3. Click Browse and find the file cmm3.txt. This is a genuine output 
file from a coordinate measuring machine (CMM). MEASUREspy 
will read up to the first 100 lines of data so that you can decide 
how to extract the information that you need from the file. 

4. Select the tab Format, Fields. 

5. Choose the option Data is positional. 

6. Scroll through and view the data. Clearly some of this is of interest, 
yet most of it is not.  Next, determine the selection rules to pick the 
aspects of this data you wish. 

7. Scroll down past the header information until you see the words 
Feature – Circle1. 
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8. To define a field, click on the “F” of Feature and drag the mouse to 
the right to highlight the entire word. Click Define Field. (Or start 
at the “e” at the end of the word and move left working to the “F.”) 
The word Feature will be highlighted in blue and this section of a 
line will be designated as Field1. 

9. Repeat this process to create three more fields in this order: 
Circle1, DIAMETER, and 47.809. 

Some of the data in the number field have a negative 
sign, six digits, and a decimal, so when you select the 
47.809, start with two spaces to left of the 4. 

10. The next step is to determine where the data will be written. Click 
on the tab Destination. 

11. Choose the option, Data will be transferred into an ASCII text file. 

12. Click Browse to select a directory. Call the file Test. 

13. Skip the optional Prompts tab, and click on Rules, Outputs.  Make 
sure the option on this tab reads Send data to file after receiving 
__1__ observation(s). 

Everything that has happened so far has created the 
conditions for reading this file and writing its data to a 
suitable place. On the Rules, Outputs tab you can now 
determine exactly what will be selected. 

14. Since 47.809 is a useful number, select data from this column as 
observations. This position does not always contain observation 
data in every line. For example, three lines above it, this column 
contains part of the word Circle1. Here is the first rule: 

Rule 1: When Field4 Is Numeric Set Obs� to Field4 

Click in the Rules grid and select choices from the drop-down lists 
to set up this rule. This rule tells MEASUREspy to read each line of 
the file, looking at all characters in columns 13 through 20.  If the 
contents of these columns look like numbers, then MEASUREspy 
will send those numbers out to the predefined destination file. 
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15. The last step is to click on the final tab, Start! and press the Start! 
button. 

16. Click No when prompted to save the file. 

17. Now click on View to open Notepad to see test.txt.  The file 
contains good data, but obviously some of these numbers are not 
diameters. The next rule addresses this.. 

18. Return to the Rules, Outputs tab. Then, click on the Clear button 
to remove the rules. 

19. Now, create a new Rule 1. You will need to type in the constant 
exactly as it occurs in the data including spaces within the term 
(in this case diameter is in all caps). 

  Rule 1: When Field3 Is Equal to DIAMETER Set Obs� to Field4 
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20. Return to the Start tab and click Start! to run the program. 

21. Click View. This is better, but you still cannot tell which diameter 
is being measured. 

22. Clear the rules and create two new rules: 

Rule1: When Field3 Is Equal to DIAMETER Set Id� to Field2 

   Rule 2: When Field3 Is Equal to DIAMETER Set Obs� to Field4 

Since the first part of each rule is the same, you can 
save time by typing in the first rule and then selecting 
Duplicate last rule from the Edit menu (or by 
pressing the hotkeys C+D. Then change the last 
two fields to match the Rule 2 above. 
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23. Click Start! to run the program again. 

24. View the destination file, Test.txt, to see the results of your rules. 
Notice that this import was unsuccessful. Why? The problem is 
that Field2 does not contain “Circle1” at the time the rule is ap-
plied; MEASUREspy has “forgotten” that line. To fix this, use a 
variable. 

25. Clear the rules by clicking the Clear button and amend the rules: 

Rule 1: When Field1 Is Equal to Feature Set V1 To Field2 

Rule 2: When Field3 Is Equal to DIAMETER Set Id� To V1 

Rule 3: When Field3 Is Equal to DIAMETER Set Obs� To Field4 

MEASUREspy is case sensitive. Feature comes in as 
upper and lower case and DIAMETER is all caps; your 
rules will need to reflect this. 
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26. Now, click Start! again to verify that test.txt contains good data. 
Note that the purpose of Rule 1 is to “remember” the feature being 
measured. This corrects the problem found in the last example. 
The information is now stored in Variable 1. 

27. As a final example, suppose you wish to collect data for a specific 
feature only.  Set up the following two rules: 

Rule 1: When Field1 Is Equal to Feature Set V1 To Field2 

Rule 2: When Field3 Is Equal to DIAMETER and When V1 Is 
     Equal to Circle1 Set Obs�To Field4 
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28. Look again at the Test.txt file to verify that this produces the 
expected output. 

By now you will understand the basic principles underlying 
MEASUREspy.  The simplicity of the rules is deceptive and you will 
see that very sophisticated data selection can be affected with just a 
few instructions.  The volume of data, the presence of comments or 
headers, and the complexity of the information make no difference to 
the output. The only requirement is that the data is in some 
structured format. This will always be the case when the data has 
been generated automatically. 

One possible variation is where the data is delimited, separated by 
some special character such as comma or a {TAB} code. In delimited 
format, each line contains the same number of fields but corresponding 
fields on two or more lines may not be the same size; the only thing 
that is important is the text between the delimiter characters. 

As far as MEASUREspy is concerned, the main difference between 
positional and delimited data is that the field structure of delimited 
data is simpler;  fields in delimited data do not overlap. The following 
example should help you to understand how to handle delimited data. 

1. Open the File Menu and select New. You do not need to save the 
file from the previous excercise. Set the source file as the ASCII 
file bath.txt, noting that the first line contains titles surrounded 
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by quotes with the remaining lines containing data values of 
various lengths and separated by commas. 

2. Click on the tab Format, Fields. 

3. Choose the option Data is separated with delimiters. 

4. Select the {COMMA} delimiter. Notice how the data is neatly 
aligned in columns and that each field is now an entire column. 

5. In Text qualifier field, select the double quote (“) to remove the 
quotation marks around the text. 

6. In the first column, point and click on the phrase Load Date to 
highlight. 

7. With Load Date highlighted, click on the Define Field button. This 
should now appear as Field1. 

8. Now define columns: Bar No., Temp (4), and Temp (7) as Fields: 2, 
3, and 4 respectively. 

9. On the Destination tab, choose the option, Data will be 
transferred into an ASCII text file. Type a new file name for the 
destination, such as ascii1.txt. 

10. Select the Rules, Outputs tab, and set the Send data to file field to 
after receiving 1 observation. 

11. Now create the following four rules: 

Rule 1: When Field3 Is Not numeric Set V1 To Field3 

Rule 2: When Field3 Is Numeric Set Id� To Field1 

Rule 3: When Field3 Is Numeric Set Id� To V1 

Rule 4: When Field3 IsNumeric Set Obs� To Field3 

Again, to save time, you may choose to type in the first rule and 
then use the Duplicate last rule feature from the Edit Menu. You 
can then edit various data to match the rules above. 
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12. Run the program and verify that Test.txt contains the data you 
expect. 

13. Finally, here is an example where the selection is based upon the 
values of the data.  Clear the rules and enter the following: 

Rule 1: When Field4 Is Within (27, 28) Set Id� To Field2 

Rule 2: When Field4 Is Within (27,  28) Set Obs� To Field4 



2 

Section 5 Configuring the Rules and Outputs 45 

14. Return to the Test.txt destination file, and confirm that only data 
values between 27 and 28 are selected and identified by their box 
numbers. 

Multiple Files 
Many large fixtures produce a short file each time a job is run; it is 
conceivable, therefore, that over a period of time, hundreds of files 
could accumulate in some directory, waiting to be processed. Here’s 
how to set up MEASUREspy to deal with this situation: 

1. Open the File Menu and select New. Then, return to the Source 
tab. 

2. Browse for the file mini1.txt and edit it to read mini*.txt. When 
entering file names, an asterisk (*) is used as a wildcard, 
representing any set of characters.  In this case, process the files 
mini1, mini2, mini3 and mini4. 

3. Click Read Data, and observe that MEASUREspy reads in all the 
files (up to the usual maximum of 100 lines) simultaneously.  You 
can then define fields. 

Use with SQCpack for Windows  
Together, MEASUREspy and SQCpack form a very powerful data 
collection and analysis system. If you intend to use MEASUREspy in 
conjunction with SQCpack, please work through the following ex-
ample. If you will not be working with SQCpack, skip this section. 

The examples shown in this section use predefined, 
SQCpack groups and characteristics. You can also set 
up outputs to write data to a new group and new 
characteristics. 

1. In a suitable SQCpack database, create a new group called Test 
with two characteristics, Circle2 and Circle4, each with a sample 
size of 1 and a data format of ##.###.  Make sure you spell the 
characteristic names exactly as above. 

2. Start a new MEASUREspy file and read in the ASCII file cmm2.txt. 
Define the fields as shown in the following screen capture. 



46 MEASUREspy 

3. On the Destination tab, select Data will be transferred into an 
SQCpack database. 

4. Browse for your database. 

5. Go to the Rules, Outputs tab. The only significant difference 
between writing to an SQCpack database and sending the data to 
other programs is in the way that outputs are assigned. 

6. Make Output1 an OBS. 

7. Click in the box under the Group heading and choose “Test” from 
the drop-down list. 

8. In the last column, Name, choose the option “Circle2.” 

9. Make Output2 an OBS, and connect it with the characteristic, 
“Circle4.” 
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10. Now create two rules: 

Rule1:  When Field1 Is Equal to Circle2 and When Field2 Is 
     Equal to 04 ID 06 02 Set Output1 To Field3 

Rule2:  When Field1 Is Equal to Circle4 and When Field2 Is 
     Equal to 04 ID 06 02 Set Output2 To Field3 

11. Verify that the output is correct. 

An alternative that allows some very general rules to be devised, is to 
amend Output1’s “Value” to “@Field1,” delete Output2, and use the 
single rule to produce the same result: 

      Rule1:  When Field2 Is Equal to 04 ID 06 02 Set Output1 To 
      Field3 

Try this to verify that this produces the same result.  How does it 
work?  The secret in this  case is that the Output is not tied to a 
specific characteristic, but rather to the contents (designated by the 
‘@’ sign) of one of the fields. Since this group has only two character-
istics, only data for those circles will be written and the rest will be 
ignored. 
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Setting up MEASUREspy to create a new SQCpack group 
and characteristic 
If you are using MEASUREspy with SQCpack, you can configure 
rules to create a new group and characteristics each time the file is 
run.  To do this, you must first set the SQCpack Preferences to allow 
it. 

1. Open the File Menu and select Preferences. 

2. In the SQCpack Preferences section, click on Allow program to 
create SQCpack groups. The option is selected if a check mark 
appears in the checkbox to the left of the field. 

3. Click on K to apply the changes and close the Preferences 
form. 

Once this preference has been selected, and you select an existing 
SQCpack database as your destination file, you need only specify 
New Group and New Id or New Char, ss= in the outputs grid. SS 
refers to sample size; select the number of readings per sample. In the 
diagram shown below, MEASUREspy will create a new group with 
one identifier and one characterisitic with a sample size of one. This 
illustration was created using the sample source data file 
CREATGP.MSW. To run this file, you may need to specify a new path 
for the source or for the SQCpack database. 

Rules for creating new groups, identifiers, and characteristics 
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An alternate way to create new groups in SQCpack is shown in the 
next two diagrams (Defined fields and Rules). This example uses the 
CLEVERAT.MSW. Again, you may need to change the path for the 
source file and/or the SQCpack database. 

Defined fields for CLEVERAT.MSW 

Rules, outputs, and the rest of the defined fields for CLEVERAT.MSW 
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Example rules 
The next several pages of the User Guide will walk you through 18 
different examples. To show you how to define fields and set up rules 
(and outputs for SQCpack), there are six examples for each of the 
three output file types. These examples show a variety of situations so 
that the most common types of applications are examined. You will 
undoubtedly be able adapt one or more examples for your particular 
application. 

Note that the examples are grouped by their output type. 
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SQCpack Example 1  

Simple data where sample size=1 
Here is a portion of an example data file with positional data found in 
the sample file cmm3.txt. 

Feature - Circle4 

           Actual    Nominal   Difference   Hi-tol   Lo-tol 

AXIS  X     -.001     .000       -.001       .130     -.130 

AXIS  Z      .005     .000        .005       .130     -.130 

DIAMETER   47.045   47.000        .045       .050      .000 

Feature - Circle5 

           Actual    Nominal   Difference   Hi-tol   Lo-tol 

AXIS  X      .003     .000        .003       .130     -.130 

AXIS  Z      .007     .000        .007       .130     -.130 

DIAMETER  180.038  180.010        .028       .050      .000 

Imagine that you want to transfer only the numbers that are under-
lined to an SQCpack database. Since other rows also contain numbers 
in this same position (numbers you do not want), you will need to 
define another field to help you. Define your fields like this: 

SQCpack Example 1, Defined fields 
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Define DIAMETER as Field1 and the underlined data as Field2. 
Notice that the fields may be defined anywhere in the file. This 
example shows data that was defined near the bottom of the display 
so that Field 2 will be wide enough to handle the largest numbers. 
Select a destination SQCpack database and set up the Rules, Outputs 
tab as shown on the next page. 

SQCpack Example 1, Rules, Output 

In this example, the SQCpack database contains a group named 
Example which has one characteristic named Diameter. These must 
be defined before you transfer the data. Here is what the data entry 
form for this SQCpack group will look like after you click Start! to 
transfer the data: 
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SQCpack Example 1, Results 
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SQCpack Example 2 

Extract ‘numeric’ data from standard columnar report 
This example uses the file cmm1.txt.  Set this file as your source file 
and define one field as shown in the upper screen capture shown 
below. 

SQCpack Example 2, One field defined 

On the Destination tab, choose the option, Data will be transferred 
to an SQCpack database.  Before you can select outputs on the 
Rules, Outputs tab, ensure that the database contains a group with 
one ID and one characteristic. In the lower screen capture, you will 
see that a group called MS Test has been created. For this simple 
example, one output and one rule are sufficient. From the last tab, 
click Start! to import the 30 rows of data. 
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SQCpack Example 2, Rule for the defined field 
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SQCpack Example 3 

Extract columnar data with feature name 
In the previous example, you extracted numeric data only. An 
improvement over that would be to capture the feature name as an 
identifier as well as the observation. 

For this example, load the file cmm1.txt and define fields and rules 
as shown. 

To run through this example you will need to turn off 
the Recognize blank fields as numeric option of the 
Preferences Menu. 

SQCpack Example 3, Defined observation and identifier 
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SQCpack Example 3, Rules and Outputs 

The resulting SQCpack output is shown on the next page. Note that 
the “trigger” to output information is that Field2 contains a 
numeric value. Consequently Rules 2 and 3 are needed to output the 
two types of data that you record in SQCpack, namely the identifier 
and the observation. 

SQCpack Example 3 Results 
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SQCpack Example 4 

Delimited data, with a sample size greater than 1 
When data is separated by a delimiter, the fields do not necessarily 
line up. In some cases the delimiting character will appear in one of 
the text fields, making it necessary to surround those fields with 
quotation marks as shown in this example. 

For this example, set bath.txt file as the source file and configure the 
program as shown in the following screen captures. 

SQCpack Example 4, Defined fields 

Define the column “Unload date” (not shown) as 
Field 1. 

For the destination, you will need to create SQCpack group (Bath 
temperatures), with one date/time identifier (Unload date), and one 
characteristic with a sample size of 2 (Temperature). Then, set up the 
Rules and Outputs as shown below. 
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SQCpack Example 4, Rules, Outputs 

SQCpack Example 4, Results 
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SQCpack Example 5 

Extract the same characteristic for several features 
This example extracts the same characteristic (using DIAMETER) 
from a number of features and sends that data to an SQCpack 
database. For this example, the source file is cmm3.txt, which contains 
a Difference column, a deviation form the nominal specification for a 
particular characteristic. The fields for this data are defined as shown 
below. 

SQCpack Example 5, Defined fields 

For this example, the destination is an SQCpack group with one 
characteristic and one identifier.  The rules are defined as follows: 
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SQCpack Example 5, Rules, Outputs 

SQCpack Example 5, Results 
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SQCpack Example 6 

The destination group/characteristics are not known until 
run time (indirection) 
Indirection is one of the most powerful features of MEASUREspy, as 
the following example will show. A very common situation is that the 
user will have many similar parts with similar characteristics. It 
would be convenient if one MEASUREspy configuration could be 
used to deal with this range of products. 

Indirection means that the destination group and/or characteristic are 
not defined explicitly, but can be extracted from the file being im-
ported. This feature enables you to devise very general rules that can 
be applied to many situations. 

For this example, the source file is cmm2.txt. Define the fields as 
shown below. For this example, Field1 is used to pick up the feature 
being measured, while Field2 is used to ensure that we only retrieve 
the diameters for these items. The data values are located in Field3. 

SQCpack Example 6, Defined fields 

In SQCpack, you will find a group called “PartA14,” which contains 
two characteristics: “Circle1” and “Circle3.” In this particular case, it 
is feasible to devise separate rules for each characteristic, since there 
are only two of them. 
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SQCpack Example 6, Rules, Output 

 

The indirection occurs in the Output grid where the “Name” column 
refers to “@Field1.” This means that the characteristic name is not 
defined explicitly, but is stored in Field1. When this field contains the 
name of something other than a valid characteristic for the group, the 
line is ignored; otherwise, the data value is extracted and allocated to 
the relevant characteristic. The resulting output is shown below. 

SQCpack Example 6, Results 
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ASCII Example 1 

Simple data to ACCII here sample size=1 
Here is a portion of an example data file with positional data found in 
the sample file cmm3.txt. 

Feature - Circle4 

           Actual    Nominal   Difference   Hi-tol   Lo-tol 

AXIS  X     -.001     .000       -.001       .130     -.130 

AXIS  Z      .005     .000        .005       .130     -.130 

DIAMETER   47.045   47.000        .045       .050      .000 

Feature - Circle5 

           Actual    Nominal   Difference   Hi-tol   Lo-tol 

AXIS  X      .003     .000        .003       .130     -.130 

AXIS  Z      .007     .000        .007       .130     -.130 

DIAMETER  180.038  180.010        .028       .050      .000 

Imagine that you want to transfer only the numbers that are under-
lined to an ASCII file. Since other rows also contain numbers in this 
same position (numbers you do not want), you will need to define 
another field to help you. 

Define DIAMETER as Field1 and the underlined data as Field2. Notice 
that the fields may be defined anywhere in the file. This example 
shows data tha was defined near the bottom of the display so that 
Field2 will be wide enough to handle the largest numbers. 
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ASCII Example 1, Defined fields 

Define DIAMETER as Field1 and the underlined data as Field2. 
Notice that the fields may be defined anywhere in the file. This 
example shows data that was defined near the bottom of the display 
so that Field 2 will be wide enough to handle the largest numbers. 
Select a destination ASCII file and set up the Rules, Outputs tab as 
shown on the next page. 

ASCII Example 1, Rules, Output 
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ASCII Example 1, Results 
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ASCII Example 2 

Column of numbers to ASCII file where sample size=3 
Sending data to an ASCII file is different from sending it to an 
SQCpack database. The latter imposes a structure on the destination 
data, while an ASCII text file does not.  Of course, if the resulting file 
is to be processed further, it should be in some well-structured 
format. The only formatting required by MEASUREspy is that each 
line must have the same number of observations (or data values), and 
this number must be entered in the Rules, Outputs tab under the 
option, Send data to file after receiving   _____  observation(s). 

This example shows data gathered from a digital voltmeter that has 
been imported from a data-logger and collected by MEASUREspy 
directly through the computer’s COM port. To extract and export the 
information to an ASCII file with a sample size of 3 the following 
applies. 

The source file used for this example is DVM.TXT. Only one field has 
been defined, as shown below. 

ASCII Example 2, Defined fields 

The destintation is set as TEST.TXT. In the Rules, Outputs tab, the 
Send data to file after ____ observations field is set to 3. The rules are 
set as follows: 
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ASCII Example 2, Rules 

A sample of the output file is shown below. Note that the output 
ASCII file will always be in comma-delimited form, and that the data 
in each line appears in the order in which MEASUREspy sends it. 

ASCII Example 2, Results 



70 MEASUREspy 

ASCII Example 3 

Retrieve an ID and two Characteristics from a delimited 
file 
This is a very basic procedure in MEASUREspy. Note that with an 
ASCII output, the observations are not distinguished in any way, so it 
is up to the user to identify the second and third column as different 
characteristics. 

This example uses the BATH.TXT source file and defines Load Date, 
Bar No., Temp (11), and Temp (12) as the fields. 

ASCII Example 3, Defined fields 

The destination is an ASCII file and the rules are show opposite. 
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ASCII Example 3, Rules, Outputs 

ASCII Example 3, Results 
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ASCII Example 4 

Extract ASCII data from very complex file 
The file cmm4.txt has an extremely complex format. Several rules are 
used to extract the desired data and write it to a simpler ASCII 
format. As with most MEASUREspy setups, there is may be more 
than one way to achieve this conversion. 

ASCII Example 4, Defined Fields 

ASCII Example 4, More fields defined 

Again the destination is an ASCII text file. The rules are as shown on 
the next page. 
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ASCII Example 4, Rules 1-4 
Rule 1: When Field1 Is Equal to ORDER NUMBER Set Linecount to 0 

ASCII Example 4, Rules 5-8 

ASCII Example 4, Rules 9-10 
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ASCII Example 4, Results 



2 

Section 5 Configuring the Rules and Outputs 75 

ASCII Example 5 

Use of Linecount to extract and export ambiguous data to 
an ASCII file 
The data you want may be buried in a table of similar data, but lacks 
identifiers that distinguish it from the data that you do not want. The 
example shown below uses the source file dl.txt, which contains 
tensile data from a number of parts. The three lines of information are 
maximum, minimum, and average. Only the last value, average, is 
required. In this example, you cannot use the usual When Field1 is 
Numeric qualifier because that will pick up all the readings, not just 
the last row. 

To handle this type of data, MEASUREspy provides a linecount 
variable, which literally counts the lines input since it was last reset. 
Use this feature in order to access only the data from every third row 
of readings. 

ASCII Example 5, Defined fields 
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ASCII Example 5, Rules 

ASCII Example 5, Results 
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ASCII Example 6 

Using multiple conditions to select specific data for an 
ASCII file 
The file SQC30DIR contains a directory listing that shows file sizes in 
one column. However, in some lines this column contains data that you 
do not want. For this type of data, you can set up a rule with an and 
when phrase so that only the file size observations will be extracted. 

ASCII Example 6, Defined fields 

Set the destination as an ASCII file and set the rules as shown on the 
next page. 
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ASCII Example 6, Rules 

ASCII Example 6, Results 
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Excel Example 1 

Before using Excel with MEASUREspy the first time, 
you will need to specify which version of Excel you 
will be using. To do this, open the File Menu and 
select Preferences. Then, on the Preferences form, 
select version 4.0 or 5.0 (for Office97)and select 
K. 

Simple data to an Excel file where sample size=1 
Here is a portion of an example data file with positional data found in 
the sample file CMM3.TXT. 

Feature - Circle4 

           Actual    Nominal   Difference   Hi-tol   Lo-tol 

AXIS  X     -.001     .000       -.001       .130     -.130 

AXIS  Z      .005     .000        .005       .130     -.130 

DIAMETER   47.045   47.000        .045       .050      .000 

Feature - Circle5 

           Actual    Nominal   Difference   Hi-tol   Lo-tol 

AXIS  X      .003     .000        .003       .130     -.130 

AXIS  Z      .007     .000        .007       .130     -.130 

DIAMETER  180.038  180.010        .028       .050      .000 

Imagine that you want to transfer only the numbers that are under-
lined to an Excel spreadsheet. Since other rows also contain numbers 
in this same position (numbers you do not want), you will need to 
define another field to help you. 

Define DIAMETER as Field1 and the underlined data as Field2. 
Notice that the fields may be defined anywhere in the file. This 
example shows data that was defined near the bottom of the display 
so that Field 2 will be wide enough to handle the largest numbers. 
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Excel Example 1, Defined fields 

Select a destination ASCII file and set up the Rules, Outputs tab as 
shown on the next page. Send the data after one observation. 

Excel Example 1, Rules 
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Excel Example 1, Results 
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Excel Example 2 

Create a new Excel spreadsheet 
Sending data into an Excel spreadsheet is similar to sending it to an 
ASCII text file. The only difference is that if the spreadsheet already 
exists, the output’s structure is fixed, while any data can be sent to a 
text file. If the spreadsheet does not exist when MEASUREspy first 
tries to write data to it, then it is created with columns headed ID1, 
ID2, OBS1, OBS2, etc. Identifier columns will be formatted as text, 
while Observation columns are formatted as general numeric. Every 
additional row of data written to this sheet will adhere to this format. 
If subsequent rows contain too many observations, the extra ones will 
be ignored; if too few, the row will be padded with null entries. The 
spreadsheet created or appended to by MEASUREspy will always be 
mswdata. 

For this example, the source file is cmm2.txt and the data fields are as 
follows. 

Excel Example 2, Defined fields 

For the destination, enter a name for a new Excel spreadsheet. 

To extract only the data in the selected field that falls between 40.0 
and 50.0,  set up rules as shown on the opposite page. 
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Excel Example 2, Rules, Outputs 

Excel Example 2, Results 
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Excel Example 3 

Extract all the data for a specific feature 
From the file cmm3.txt, we will extract the data for a named feature 
(Circle3), but without making any assumptions about the number of 
characteristics that may appear in the file. For these rules to work 
correctly, the option Recognize blank fields as numeric must be 
turned off. To do this, open the File Menu and select Preferences. If 
there is no checkmark in the box to the left of the option, it is off. Off 
is the default setting for this option. 

Excel Example 3, Define fields 

In the rules shown below, note that Date is specified as an identifier. 
This information is not available from the data. However, 
MEASUREspy can pull the computer date. Again data is being 
extracted to a new Excel spreadsheet. 
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Excel Example 3, Rules 

Typically, the results will be accumulated in a spreadsheet over time, 
but the following screen capture shows the results of running 
MEASUREspy just once. 

Excel Example 3, Results 
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Excel Example 4 

Extract delimited data into Excel 
Extracting data for use with Excel is similar to extracting data for use 
with SQCpack or ASCII files. 

For this example, the source file is BATH.TXT. We are interested in the 
data for Temp(6), but only when Temp(4) is less than Temp(5). Each 
of these fields must be defined. 

Excel Example 4, Defined fields 

Again, a new Excel file is used for the destination. 

To compare fields, preferences must be set to allow the comparison. 
To do this, open the File Menu and select Preferences. In the Prefer-
ences form, click on Allow Fields to be subjects of comparisons so 
that a check mark appears in the box to the left of the field. This 
option creates drop-down lists in the constants columns;  @Field2 
under constant2 came from such a list. 
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Excel Example 4, Rules 

Excel Example 4, Results 
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Excel Example 5 

Scan a directory for new files every 60 seconds, and write 
to Excel 
When a device, such as a CMM, regularly generates files each time a 
part is measured, you may want to set up MEASUREspy to automati-
cally look for new files. This saves you from manually running the 
program each time a new file is created. 

The following diagram shows the settings on the Source tab. Note the 
use of a wildcard (*) character in the file name to collect all files that 
appear in the directory.  To set up this type of configuration you will 
need a typical file, so that you can establish fields and rules. 

Excel Example 5, Data Source 
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Excel Example 5, Defined Fields 

You will see from the rules that the part number, feature name, and 
data value into our Excel spreadsheet are being collected. For the 
rules to work, you will need to turn off the option, Recognize blank 
fields as numeric, through the Preferences form. An alternative to 
this would be to enter a rule that recognizes the final line (the one 
containing the data) by using Linecount. 

Excel Example 5, Rules 1-4 
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Excel Example 5, Rule 5 

Excel Example 5,Results 
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Excel Example 6 

Prompt for a feature at run time and write data to Excel 
MEASUREspy can prompt for the answers to up to ten questions as 
soon as it starts to import data. This example, will ask for a batch 
number for use as an identifier, and a feature name to be used as as 
basis for the data extraction. 

By default, MEASUREspy expects the user to type in the constants 
columns in the rules grid. Before defining the rules, turn on the Allow 
Answers to be the subjects of comparisons option found on the 
Preferences form. 

The source file for this example is CMM2.TXT. 

Excel Example 6, Defined fields 

The destination is a new Excel spreadsheet and the Prompts are 
shown in the first diagram on the next page. 



92 MEASUREspy 

Excel Example 6, Prompts 

Excel Example 6, Rules 
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A sample of the output is shown below. In this case, A-123 is the batch 
code, and Circle2 is the feature selected to measure. 

Excel Example 6, Results 
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Reference 

Each rule is comprised of up to eight parts as follows: 

When This section is required and is the main trigger for an 
action to occur. Generally, the information used here 
will be a field, but it may also be a “Count” (the 
count of observations sent out so far in the sample) or 
a “Linecount” (the number of input data lines since 
this count was last reset). 

Is This information is also required. The valid values 
are: 

Equal to If the items being compared are 
numeric, they must have the same 
value. If they are not numeric, they 
must be identical in length, case, and 
punctuation. 

Not equal to This is the opposite of equal. 

Like When used with numbers, this means 
“equal.” Otherwise, the items are 
stripped of all spaces and then 
compared without regard to case. 

Greater than For numbers, the meaning is obvious. 
Otherwise, the comparison is alpha-
numeric and means “after in the 
alphabet.” So, for example, ”Rimsky- 
Korsakov,” is greater than 
“Rachmaninov” since alphabetically, 
“Ri” comes after “Ra.” 

Less than This term is the opposite of “greater 
than.” For numbers, the meaning is 
obvious. Otherwise, the comparison 
is alphanumeric and means “before 
in the alphabet.” Thus, “frog” is less 
than “toad,” since “f” comes before 
“t.” 
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Within The item must be between two 
values. Whether the comparison is 
numeric or not, the above guidelines 
apply. The two values are enclosed in 
brackets, smallest first as in the 
following examples: 

(2,3) means greater than 2 and 
less than 3 

[11.5, 13) means greater than or 
equal to 11.5 and less than 
13 

[a, z] means anything starting 
with a lowercase letter 

Outside This is the opposite of “Within.” 

Numeric This designation means that the item 
can be evaluated as a number. 
Normally an empty field would not 
be regarded as numeric, but you can 
vary this function by going to the 
Preferences… menu (located under 
File) and clicking to activate the box 
next to the phrase, “Recognize blank 
fields as numeric.” 

Not numeric This is the opposite of “Numeric.” 

Blank Using this term means that the field 
consists entirely of space characters 

Not blank This means that the field contains at 
least one non-space character. 

The section following “Is” may require an entry as a parameter for 
the “Is.” Usually, this will be typed in by you; however, lists of fields, 
variables, and answers can be added by selecting the comparison 
options in the General Preferences section of the Preferences form. 
This form is available through the File Menu’s Preferences command 
For example, you set up a prompt to ask for the operator’s name, 
Ans1 can be used as a comparison to ensure that only one particular 
operator’s data is selected. 
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And when This section is optional and is provided to allow for 
more complex comparisons to be made. If it is used, 
the following two or three sections must also be 
completed. It is very similar to the when section 
above, except that the values of variables may also be 
compared. 

Is This section uses the same criteria as the first is 
section. 

Again, if the Is requires a parameter, it is entered or 
selected in the next section. 

Set The main selections here are the Outputs. For Excel 
and ASCII, these are either Id� for an identifier or 
Obs� for an observation. Each time “Obs�” is sent, 
a count is incremented that can be accessed by the 
user, and which is also used to determine when the 
sample should be sent to the destination file. Also 
available are the list of “variables” currently in use, 
plus one other that can be set in this rule. Linecount 
resets the internal count of data lines to 0. 

To The list includes all fields and variables currently in 
use. If there are any questions listed on the Prompts 
tab, the answers to those questions can be retrieved 
here. If the import is from an ASCII file, the file name 
(minus the extension) is available as Thisfile. 
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Appendix A 

Common Questions & Answers 

Q: What is MEASUREspy? 

A: MEASUREspy is a sophisticated program that  extracts data 
from almost any data-generating device.  The data can then 
be transferred directly into an SQCpack database, an Excel 
spreadsheet, or an ASCII text file. 

Q: What kind of data will MEASUREspy import? 

A: Data must be in ASCII (plain text) format, received either 
from a file or through the computer’s COM (serial) port. 
Most measuring devices should be able to provide suitable 
serial data either directly or via a Print Report command. 

Q: How is MEASUREspy different from PORTspy PLUS for 
Windows? 

A: PORTspy Plus deals with simple devices, like micrometers, in 
real-time while MEASUREspy collects data from more 
complex devices like CMMs in batch mode.  Together, 
PORTspy Plus and MEASUREspy can handle almost any data 
capture job. 

Q: How can I access the results obtained from the Prompts 
questions? 

A: The answer to each question is available in the rules grid as 
Ansx, where x represents the question number. 

Q: What is the largest file I can import with MEASUREspy? 

A: The size of the file is irrelevant; MEASUREspy reads and 
processes data one line at a time.  The maximum length of 
any one line is 2,048 characters. 

A 
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Q: My shop-floor operators need to use MEASUREspy, but I 
don’t want them to be able to tamper with the files.  What 
can I do to prevent tampering? 

A: You can restrict access by setting up an icon or shortcut with 
a /U command. This runs MEASUREspy in “user mode,” 
which provides limited functionality. To do this: 

In Windows 3.1 

1. Open the Program Manager and click on the group 
window that you want to use. 

2. Open the File Menu and select New. The New Pro-
gram Object window will open. 

3. Select Program Item followed by K. The Pro-
gram Item Properties window will open. 

4. The cursor will be resting on the Description field. 
What you type in this field will appear below the icon 
in the Program Manager, so you may want to type a 
file name, product or line number, or batch 
information. 

5. Move the cursor to the Command Line field and type 
your command line. You can restrict access to just one 
file, or allow the operator to load and run any file. To 
restrict access to a specific file: 

C:\MSPY\MSPY10.EXE c:\XXXX\YYYY.MSW /U 

Where XXXX is the directory in which the file is 
located and YYY is the name of the MEASUREspy 
file.  /U is the command that restricts access, so 
that the user can access only the Start tab. 

If you want the allow the operator to open several 
files, but not edit the settings, enter the following 
command: 

C:\MSPY\MSPY10.EXE  /U 

6. Select K. 
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For Windows 95 or higher: 

1. Highlight the MSPY.EXE file in the Windows Explorer. 

2. Open the File Menu and select Create Shortcut. A 
shortcut icon will be added to the directory. 

3. Right click on the shortcut icon to open the pop-up 
menu. Then, select Properties. 

4. You can restrict access to just one file, or allow the 
operator to load and run any file. To restrict access to 
a specific file, enter the following command line in 
the Target field: 

C:\MSPY\MSPY10.EXE c:\XXXX\YYYY.MSW /U 

Where XXXX is the directory in which the file is 
located and YYY is the name of the MEASUREspy 
file.  /U is the command that restricts access, so that 
the user can access only the Start tab. 

If you want to allow the operator to open several 
files, but not edit the settings, enter the following 
command line in the target field: 

C:\MSPY\MSPY10.EXE  /U 

5. Select K. 

6. To rename the icon, right click on the icon, and select 
Rename from the pop-up menu. 

7. To move the icon to the desktop, click on it and drag it 
to from Windows Explorer to the desktop. 

Q: I see an “and” in the rules, but no “or.”  Why not? 

A: You don’t need an “or” command.  To implement the “or” 
function, use two rules like this: 

When something do this 

When something else do this 

As each rule is applied in turn to each line, “this” will be 
done when either the first “something” or the second 
“something else” is true. 
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Q: My text files are delimited by a tilde (~), which is not on the 
list of delimiters. What should I do? 

A: Edit the program’s initialization file, MSPY.INI in the 
\WINDOWS directory and add the following line to the 
[General] section: 

ExtraDelimiter=~ 
The next time you start MEASUREspy,  tilde will be the 
first delimiter on the list. 

Q: When I connect my hardware to MEASUREspy, it takes one 
reading and then stops.  Why? 

A: When MEASUREspy has started reading data from the 
COM port, it times out if no data is received after a set 
period. Usually this means that the download has finished. 
The default setting is  ComTimeout=3 in the MSPY.INI file, 
which means this occurs after three seconds.  The maximum 
setting can be 60 seconds.  If data is arriving any less 
frequently from your device, maybe PORTspy Plus for 
Windows would be a more appropriate interface. 

Q: Why would I ever check the Allow answers to be the 
subjects of comparisons option found on the Preferences 
form? 

A: Here is one possible reason: if one of your prompts asks for 
Operator Name, you could select just the data for that 
operator by comparing the name field with the answer to 
this question. 

Q: What does Import newer files only mean? 

A: Some devices (like CMMs, for example) generate many 
small files, one for each part measured. MEASUREspy can 
periodically scan for those files automatically.  When it finds 
one or more created since its last scan, it will import them. 
Checking this option ensures that files are only imported 
once.  Alternatively you could elect to Delete source files 
after use, but only if you don’t need them for anything else. 
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Q: What is the ThisFile option in the Rules’ To column? 

A: ThisFile is the name (without the extension) of the file cur-
rently being imported.  Many devices create individual files 
for each job with the job number being the file name. 
MEASUREspy can pick this up and send it to a Job Number 
identifier in SQCpack. 

Q: In my Excel report, I expect a column of identifiers and a 
column of observations, but only the observations are appear-
ing.  What’s wrong? 

A: Your rules are not in the correct order.  Remember that for 
every line of data read, MEASUREspy applies each rule in 
turn.  Also recall that the trigger for sending data is the count 
of observations.  Always send identifiers first so they are 
correctly associated with their data values. 

Q: I imported some data to an SQCpack database. Now when I 
click View on the Start! tab, I get an error message.  What’s 
wrong? 

A: You need to define the location of your SQCpack program. 
Select Preferences from the File Menu and either type in the 
file’s location or use the browse feature (…) to locate the 
SQCpack program file. (The location for this file may be 
something like, C:\sqcwin30\sqcwin30.exe.) 

Q: I want to write data to an SQCpack database where the 
characteristic name is contained in V1 (one of the rule’s 
variables), but @V1 is not on the list. 

A: The list shows all the variables known at the time.  You will 
need to define the rule that creates the variable first, before 
you can attach it to the Output. 
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Q. My data fields include text and numeric characters, for 
example X=34 Y=67. How can I extract just the numbers?  

A. When MEASUREspy sends an Observation (data value) to 
any destination, it automatically sends the numeric charac-
ters along with commas and decimal points. For observation 
fields that contain both alpha and numeric data, you can 
force MEASUREspy to ignore the text and extract only the 
first numeric value.  To do this, you will need to add a line to 
the MSPY.INI file: 

ForceNumericObs=1 

Type it exactly as it appears above. This tells MEASUREspy 
to ignore all non-numeric characters in an observation field 
and to extract only the first numeric value. To capture both 
numeric values, you would need to define two fields. For 
example, one field would capture X=34 and the other field 
would capture Y=67. 
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